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Chapter 1: Basic Skills

Overview

To create a document with Word, you usually follow these steps:
* Create or open a document
* Type and format the text
* Revise the text and formatting
* Save the document
* Print the document
* Close the document and/or exit Word

This chapter gets you started by describing how to create and open a document, type 
your text, save your document, and exit Word.

NOTE____________________________________________________________
The procedures in this chapter assume that you know the basics of using the keyboard. 
If you’re using a mouse, you should also know how to point, click and double-click the 
mouse button, and drag with the mouse. To learn these basics, see the online lesson, 
“Using the Keyboard or the Mouse.”
_________________________________________________________________

Choosing Commands

A command is an instruction to Word to perform an action. You choose a command by 
selecting one of the menus on the menu bar, and then choosing the command from the 
menu.

To choose a command
KEYBOARD:

1.  Press ALT to activate the menu bar.
One letter in each menu name becomes bold. (The bold letter is sometimes 
called the accelerator key.)
2.  Press the bold letter of the menu you want.
Word displays the commands on that menu.
3.  Press the bold letter of the command you want.

MOUSE:
1.  Point to the name of the menu you want to select and click the left mouse 
button.
Word displays the commands on that menu.
2.  Point to the name of the command you want to choose and click the left 
mouse button.

NOTE____________________________________________________________
If a command doesn’t apply to what you are doing, the command name will be dimmed 
and you won’t be able to choose it.
_________________________________________________________________



If a command is followed by an ellipsis (...), it displays a dialog box when you choose it. 
You use a dialog box to supply information that Word needs to carry out the command.

If a command is not followed by an ellipsis, it doesn’t display a dialog box and Word 
carries out the command immediately.

To cancel the menu bar, a menu, or a dialog box
* Press ESC.

To undo a command

The Edit Undo command reverses your most recent action in Word. You must use Edit 
Undo immediately after choosing the command you want to reverse.
* Choose Edit Undo (ALT, E, U).

You can undo the following commands:
* All Edit commands except Edit Search and Edit Go To
* All Insert commands
* All Format commands except Format Define Styles
* All Utilities commands except Utilities Repaginate Now and Utilities 
Customize

Creating a Document

When you start Word, it automatically creates a document for you. You can create a 
document yourself any time you’re working in Word. When you create a new document, 
Word gives it a temporary name and displays the name on the screen. You can start 
typing immediately.

The text you type is temporarily held in the computer’s memory. To retain the text for 
later use, you must save the document to a disk. When you save the document, you 
give it a unique name. For more information, see “Saving a Document,” later in this 
chapter.

Creating a Document When You Start Word

When you start Word, a blank document is automatically created with a temporary 
name. If you prefer, you can give the document a permanent name.

NOTE____________________________________________________________
When you start Word with a floppy disk system, you must use the Word Program disk 
created by Setup; for Word to run properly, you can’t copy the files directly from the 
Master disk. Make sure the Word Program disk is in drive A and the system prompt is 
displayed. With a 360K floppy disk system, use Program disk 1. If you have a hard disk 
system, make sure that you are in the directory containing the Word program file or that 
the Word program file is part of your current path.



_________________________________________________________________

To start Word and create a new document
1. Type word at the system prompt.
2. Press ENTER.

Word starts and displays a blank document. The document is temporarily 
named Document1. 
3. Begin typing the new document.

To start Word and create a new, named document
1. Type word at the system prompt.
2. Press the SPACEBAR.
3. Type a name for the new document (eight characters maximum).
4. Press ENTER.
5. When Word asks you if you want to create a new document, press ENTER
or click OK. 

Word starts and displays a blank document. The document’s title bar 
shows the name you typed at the system prompt.
6. Begin typing the new document.

Creating a Document After You Start Word

You can create a new document at any time while you are working with Word. When 
you create a second document it fills most of the screen, overlapping the previously 
displayed document. Word temporarily names your new documents in numerical order, 
starting with Document1, Document2, Document3, and so on.

You use commands from the Window menu to move between open documents or to 
arrange the documents so that they are all visible on your screen.

To create a new, unnamed document
1. Choose File New (ALT, F, N).

The File New dialog box is displayed.
2. Choose OK (ENTER).
3. Begin typing the new document.

When you choose File New, Word assumes that you are creating a document in the 
current drive and directory.

With File New, Word also proposes that you attach the default style sheet, 
NORMAL.STY, which provides automatic styles for paragraphs, sections, and character 
font and size.

If there’s already a document open when you choose File New, the new document 
overlaps the first one. You use the Window menu to move between open document or 
to arrange the open documents so that they are all visible on your screen.



Opening an Existing Document

As you work with a document, Word stores it temporarily in the computer’s memory. To 
store it permanently, you must save the document to a disk. For more information, see 
“Saving a Document,” later in this chapter.

Once a document is saved on disk, you can open it in Word and work with it. You can 
open a document either when you start Word or while you are working in Word.

To start Word and open an existing document
* Type word filename at the system prompt.

Word starts and displays the existing document.

Filename is the name of the document you want to open. If the document has a DOC 
extension, you don’t have to type the extension. If the document has an extension other 
than DOC, type the extension after the filename; be sure to type a period between the 
filename and the extension. If the document has no extension, type a period (.) after the
filename.

To open an existing document
1. Choose File Open (ALT, F, O).
2. Do one of the following:

* In the File Name box, type the document name.
If the file is not located in the current drive or directory, include the file’s 
pathname (for example, B:\MEMOS\SALES).
Press BACKSPACE to correct any errors.
* Press ALT+F to move to the Files list, press the DOWN ARROW 
key, then use the direction keys to select the filename.
If the file is not located in the current drive or directory, press ALT+D to 
move to the Directories list. Press the DOWN ARROW key until the 
appropriate drive or directory name is selected, and press ENTER. Then 
choose the document name from the Files list. Select the two dots (..) to 
move up one level in the directory structure.
* If you have a mouse, double-click the filename with the left mouse 
button, and skip step 3, following. You may have to scroll the Files box to 
see the filename.
If the file is not located in the current drive or directory, double-click the 
directory name in the Directories list. Double-click the two dots (..) to move
up one level in the directory structure. Then choose the document name 
from the Files list.

3. Choose OK (ENTER).

Word opens the document. If there’s already a document open, the second document 
overlaps the first one. You use the Window menu to move between open documents or 
to arrange the open documents so that they are all visible on your screen.



When you choose File Open, the dialog box lists only documents in the current directory
that have the DOC extension.

Typing Text

Text comprises letters, numbers, spaces, and special symbols. Typing text is a lot like 
using a typewriter. However, there are some differences:
* A blinking underscore, called the cursor, shows where you are in the document. As 
you type, the cursor moves to the right.
* If you type new text in a space where text already exists, the new text is inserted at 
the cursor position; the existing text moves to the right.
* You do not press ENTER to end lines. The text you type automatically moves to the 
next line if it doesn’t fit within the page margins. This is called wordwrap. If you add or 
delete text, wordwrap automatically rearranges the lines of text to accommodate the 
new text or fill gaps created by the deleted text.

You control the way text appears on the page by formatting it. For example, you can 
make text bold or italic, or center a paragraph of text on the page. You can format text 
either as you type it or after you type it.

To insert text
1. Use the DIRECTION KEYS to position the cursor where you want to insert
the text, or point with the mouse and click the left mouse button.
2. Begin typing.
Word inserts the text. The cursor and any existing text move to the right.

For more information about positioning the cursor, see “Scrolling Through a Document” 
in Chapter 2, “Scrolling, Selecting Text, and Choosing Commands.”

To erase a mistake
* Press BACKSPACE.

BACKSPACE erases characters as the cursor backs over them, except when you
turn on overtyping, as explained in the next procedure. The cursor and all text to the 
right of the cursor shift to the left to fill the gap left by the erasure.

BACKSPACE also erases from the beginning of a line to the end of the previous 
line. If you accidentally press ENTER before you want a new paragraph, you can press 
BACKSPACE to join the lines together again.

To overtype text

You can also choose to type new text over old text. This is called overtyping.
1. Press INS to turn on overtyping.

OT appears on the status bar at the bottom of the screen, indicating 
overtype mode.
2. Begin typing.

Word types new text over the old text.



3. Press INS again to turn off the overtype mode.

In the overtype mode, you can only backspace over new characters you type. Word 
remembers where you began overtyping and beeps if you try to backspace past that 
point.

NOTE____________________________________________________________
In Word, version 5.5, INS turns on the overtype mode. However, in previous versions of 
Word, INS inserted text from the scrap. If you’ve used a previous version of Word, you 
may want to continue using INS to insert text from the scrap. You can make this choice 
during Setup, or by turning off the Use INS for Overtype Key check box in the Utilities 
Customize dialog box.
_________________________________________________________________

To insert a nonbreaking space

At times you don’t want a line break between two words. For example, you may not 
want to break a person’s first and last name over two lines. Or, if you have justified 
lines, you may not want Word to expand any of the spaces in a mathematical formula or
a computer command. For such cases, Word provides a nonbreaking space.

* Press CTRL+SHIFT+SPACEBAR to space between words you want to keep on one
line.

HINT_____________________________________________________________
Space characters are nonprinting characters that are normally not displayed. To see 
them, choose View Preferences and turn on either the Show All check box or the 
Spaces check box. With the Show All check box turned on, a regular space is shown as 
a dot and a nonbreaking space as a blank space. With the Spaces check box turned off,
a nonbreaking space looks the same as a space typed with the SPACEBAR. For more 
information about using check boxes, see “Using Dialog Boxes” in Chapter 2, “Scrolling,
Selecting Text, and Choosing Commands.” For more information about nonprinting 
characters, see Chapter 3, “The Word Screen.”
_________________________________________________________________

To repeat your last typing
* Press F4

Word repeats all the text you have typed since you last used a command or 
moved the cursor, no matter how much text you’ve typed.

Repeating your typing is useful, for example, if you want to quickly add the same 
sentence or phrase to several places in a long document. To accomplish this, you do 
the following:

1. Type the text.



2. Move the cursor to the next place you want to insert the same text.
3. Press F4.
4. Repeat steps 2 and 3 in all the places where you want to insert the text.

HINT_____________________________________________________________
If you want to save some text to repeat in many places in one or more documents, you 
can use either the Edit Copy command or a glossary.
_________________________________________________________________

To start a new paragraph
* Press ENTER.

Word inserts a paragraph mark.

In Word, a paragraph is any text and formatting preceding and including a special 
character called a paragraph mark. The paragraph mark contains formatting instructions
—such as indents and tab settings—for that paragraph. If you delete a paragraph mark, 
you also delete the formatting for the paragraph.

When you press ENTER, Word creates a new paragraph. Until you set a new format, 
each new paragraph is formatted like the preceding paragraph.

HINT_____________________________________________________________
Paragraph marks are nonprinting characters. They are normally not displayed, but you 
may want to display them while formatting your document. To see them, choose View 
Preferences and then turn on either the Paragraph Marks check box or the Show All 
check box. For more information about using check boxes, see “Using Dialog Boxes” in 
Chapter 2, “Scrolling, Selecting Text, and Choosing Commands.” For more information 
about nonprinting characters, see Chapter 3, “The Word Screen.”
_________________________________________________________________

Here are some reasons to start a new paragraph:
* You need a new paragraph in the course of your writing.
* You want a heading for a section of the document. For formatting purposes, it is 
easier to make a heading a separate paragraph.

To start a new line without creating a new paragraph

Wordwrap starts new lines automatically when the text reaches the right margin 
or indent. When you want text to stay together in one paragraph, just continue to type 
and let wordwrap take care of the lines. Sometimes, however, you may want to control 
the length of particular lines. For example, you may want to control the length of lines 
when typing tables, addresses, or poems. You can do this without creating a new 
paragraph, thus maintaining the same paragraph formatting.

To start a new line before reaching the right margin or indent:



* Press SHIFT+ENTER.

Word starts a new line without starting a new paragraph and inserts a newline 
character. The newline character is displayed on the screen if either the Show All check 
box or the Paragraph Marks check box in the View Preferences dialog box is turned on.

To break a page manually

A page break tells your printer where to end one page and begin printing a new one. 
Word breaks pages for you automatically as you type text. If you prefer, you can break a
page at a specific place.

1. Move the cursor to where you want to begin a new page and choose 
Insert Break (ALT, I, B).
2. Turn on the Page option.
3. Choose OK (ENTER).

NOTE____________________________________________________________
To insert a page break quickly, move the cursor to where you want to begin a new page 
and press CTRL+ENTER.
_________________________________________________________________

Word displays a dotted line on your screen to show a page break. For automatic page 
breaks, the dots in the line are widely spaced. For manual page breaks, the dots are 
closer together. You can select a manual page break and delete, copy, or move it. You 
cannot select an automatic page break.

To type foreign and special characters

The foreign and special characters you are able to use depend on your printer’s 
capabilities. 

To see which characters your printer can print, run the character_test macro in the 
MACRO.GLY file on the Word Program disk 3. This macro prints all the extended 
characters (and code numbers) available with your printer.
* To type a special character, turn on NUMLOCK, and then hold down the ALT key 
while typing the appropriate number code on the keypad.

Saving a document

The text you type into a new document and the changes you make to an existing 
document are held temporarily in the computer’s memory. To retain this information, you
must save the document to a disk. You can save and name a new document, or you can
save the changes you’ve made to an existing document. After you’ve saved a 
document, it remains on your screen, and you can continue to make changes.



Because power interruptions can cause you to lose all changes to your document since 
you last saved it, it’s a good idea to save often as you work—every 15 minutes is a 
good rule of thumb.

If you have a hard disk system, Word proposes saving existing documents to the 
current directory. However, if you have changed the default directory using the Options 
button in the File Open or File Save As dialog box, Word proposes saving existing 
documents to the default directory, rather than the current directory.

If you have a floppy disk system, Word proposes that you save your documents on the 
disk in drive B. To do so, you’ll need to have a formatted disk in drive B.

To save a new, unnamed document
1. Choose File Save As (ALT, F, A).
2. In the File Name box, type a name (eight characters maximum).

Word proposes that you save the document in the drive and directory from
which it was opened or created. If you want to save the document to a different 
drive or directory, do one of the following:
* Type a pathname in the File Name box (for example, A:\REPORTS\
SALES). 
* Press ALT+D to move to the Directories list. Press the DOWN ARROW 
key until the drive or directory name is selected, and press ENTER. Then type 
the document name in the File Name box.

NOTE_______________________________________________________
Word proposes that you save all documents in Word format, unless they were 
originally in text format.
____________________________________________________________
3. Choose OK (ENTER).
Word displays summary information about the document that can assist you and 
your co-workers in retrieving it later.

Before proceeding to step 4, you can type additional information, such as 
the author’s name or specific words contained in the document, to assist in later 
retrieval.
4. Choose OK (ENTER). 

NOTE____________________________________________________________
You can use the Utilities Customize command to tell Word not to display the summary 
information when you are saving a new document.
_________________________________________________________________

To save an existing document
* Choose File Save (ALT, F, S).



Word saves the document with its current name. If you haven’t given the document a 
name, Word displays the File Save As dialog box. To use the dialog box, follow steps 2-
4 in the previous procedure, “To save a new, unnamed document.”

IMPORTANT_______________________________________________________
If you’ve opened any documents, style sheets, or glossaries from a floppy disk, make 
sure that you save and close all of these files before you change floppy disks. You 
should also clear the scrap before changing floppy disks. You can use a supplied 
macro, clear_scrap, to do this.
_________________________________________________________________

Closing a Document

You can close a document at any time in Word.

To close a document
* Choose File Close (ALT, F, C).

If you’ve made changes to your document since you last saved it, Word displays 
a message asking whether or not you want to save the changes. 
* Choose Yes to save the document with any changes you’ve made.
* Choose No to discard all unsaved changes.
* Choose Cancel (ESC) to cancel the File Close command.

If your document is unnamed, Word displays the File Save As dialog box. To save each 
document, follow steps 2-4 in the procedure, “To save a new, unnamed document,” 
earlier in this chapter.

NOTE____________________________________________________________
You can close all your documents at once by choosing the File Close All command. You 
can also close a single document by using the Window Close command, or, if you have 
a mouse, by clicking the close icon at the upper-left corner of the document window.
_________________________________________________________________

Exiting Word

You can exit Word temporarily to run system commands or other programs, or you can 
exit and end your Word session.

To exit Word temporarily and execute a single command
1. If you are using DOS, choose File DOS Commands (ALT, F, D).

If you are using OS/2, choose File OS/2 Commands (ALT, F, D).
2. Type the operating system command.
3. Choose OK (ENTER).
4. Press any key to return to Word.

To exit Word temporarily and execute a series of commands
1. If you are using DOS, choose File DOS Commands (ALT, F, D).



If you are using OS/2, choose File OS/2 Commands (ALT, F, D).
2. With COMMAND (CMD for OS/2) in the text box, choose OK (ENTER).
3. Type the operating system command.
4. Type exit.
5. Press any key to return to Word.

To exit Word and end your Word session
* Choose File Exit Word (ALT, F, X).

If you have already saved all your new documents and all changes to your 
existing documents, choosing File Exit Word ends the Word session and returns you to 
the system prompt.

If any of your open documents have changes that you haven’t saved, Word 
displays a message asking you whether or not you want to save changes.
* Choose Yes to save the document with your changes.
* Choose No to discard all unsaved changes.
* Choose Cancel (ESC) to cancel the File Exit Word command.

If any of your open documents, style sheets, or your glossary file are unnamed, Word 
displays the File Save As dialog box. To save each document, follow steps 2-4 in the 
procedure, “To save a new, unnamed document,” earlier in this chapter.

NOTE____________________________________________________________
During Setup, Word creates a file, MW.INI, to store settings for a number of options that 
affect the way Word looks on your screen. Every time you exit Word, any changes 
you’ve made to these settings are stored in MW.INI. If you accidentally delete MW.INI, 
Word recreates the file using the default settings when you exit Word.
_________________________________________________________________



Chapter 2: Scrolling, Selecting Text, and Choosing Commands

Overview

This chapter describes three basic elements of using Word:
* Scrolling moves a document through the window on your screen so that you can 
see all your text, no matter how long or wide it is.
* Selecting text lets you specify the text you want to work with next.
* Choosing commands lets you control Word and accomplish your tasks.

These three processes underlie all the main steps of creating a document in Word. 
Learning them will give you a solid foundation for the more complex word processing 
tasks and procedures.

You can scroll through a document, select text, and choose commands using either the 
keyboard or a mouse.

NOTE____________________________________________________________
The procedures in this chapter assume that you know the basics of using the keyboard. 
If you’re using a mouse, you should also know how to point, click and double-click the 
mouse buttons, and drag with the mouse. To learn these basics, see the online lesson, 
“Using the Keyboard or Mouse.” 
_________________________________________________________________

This chapter assumes that you are using the default key assignments for Word, version 
5.5. These assignments differ from key assignments in Word, version 5.0. If you used 
Word, version 5.0, you may want to continue using the Word 5.0 key assignments. You 
can make this choice during Setup, or by turning on the Use Word 5.0 Function Keys 
check box in the Utilities Customize dialog box.

Scrolling Through a Document

Your document may contain more text than can fit in the window on your screen. You 
can scroll through the document to bring different parts of it into view.

A blinking underscore, called the cursor, shows where you are in a document. You can 
move the cursor around using various keys or mouse actions. When your destination is 
outside the current window, Word scrolls through the document to keep the cursor 
visible.

NOTE____________________________________________________________
If you have a mouse, its pointer is a rectangle in text mode and an arrow in graphics 
mode.

As you move the cursor, the page and column it’s in and, optionally, the line number are 
displayed on the status bar in the lower-left corner of the screen.



_________________________________________________________________

For more information on the status bar, see “The Basic Word Screen,” in Chapter 3, 
“The Word Screen.”

When you scroll, the scroll boxes on the window border indicate which portion of the 
document you’re viewing.

With a mouse, you use the arrows and boxes on the scroll bars to scroll quickly through 
your document. If you don’t have a mouse, you can turn off the horizontal and vertical 
scroll bars individually by using the View Preferences command. Turning off the scroll 
bars simplifies your screen, and, if you turn off both scroll bars and window borders, you
can view an additional line of text. For information about using the scroll bars with a 
mouse, see the procedure “To move the cursor and scroll with the mouse” later in this 
chapter. For information about turning off the scroll bars, see “Customizing the Word 
Screen,” in Chapter 3, “The Word Screen.”

To move the cursor and scroll with keys

To move the cursor to Press
---------------------------------------------------------------------------------------------------------
Character to right RIGHT ARROW
Character to left LEFT ARROW
First character of next word CTRL+RIGHT ARROW
First character of previous word CTRL+LEFT ARROW
Line below DOWN ARROW
Line above UP ARROW
Last character in line END
First character in line HOME
First character of next paragraph CTRL+DOWN ARROW
First character of previous paragraph CTRL+UP ARROW
First character in last line of window CTRL+PGDN
First character in window CTRL+PGUP
Last character in document (endmark) CTRL+END
First character in document CTRL+HOME
---------------------------------------------------------------------------------------------------------

To scroll text using the keyboard sometimes requires that Scroll Lock be turned on (see 
table, following). To turn Scroll Lock on, press the SCROLL LOCK key; SL will be 
displayed in the status bar. To turn Scroll Lock off, press the key again.

To scroll text Press
---------------------------------------------------------------------------------------------------------
Up one line UP ARROW (Scroll Lock on)
Down one line DOWN ARROW (Scroll Lock on)
Up one window PGUP



Down one window PGDN
Left one-third window LEFT ARROW (Scroll Lock on)
Right one-third window RIGHT ARROW (Scroll Lock on)
---------------------------------------------------------------------------------------------------------

NOTE____________________________________________________________
In Word, version 5.5, when you’ve typed to the end of the last line at the bottom of a 
window, Word wraps the text and starts a new line. In Word, version 4.0, Word scrolled 
up by half a window when you reached the end of the last line. The bottom half of the 
window was empty. To scroll as in Word, version 4.0, type word /y when you start Word.
To return to the Word, version 5.5 behavior, type word /z when you start Word.
_________________________________________________________________

To move the cursor and scroll with the mouse
* To move the cursor, point to the location where you want the cursor and click the left
mouse button.
* To scroll with the mouse, use the appropriate action(s) listed in the following table. 
Note that, in each of the following actions, you use the left mouse button.

To scroll In the scroll bar
---------------------------------------------------------------------------------------------------------
One line at a time Click the up or down scroll arrow.
One column at a time Click the left or right scroll arrow.
One screen at a time Click above or below the vertical 

scroll box.
Continuously through the document Point to the up or down scroll arrow 

and hold down the left mouse button.
One-third of the window (horizontally) Click to the left or right of the 

horizontal scroll box.
To a general location in the document Drag the scroll box to a relative 

percentage of the document’s length or 
width. (For example, move the scroll box
to the middle of the vertical scroll bar to 
view the middle of the document.)

---------------------------------------------------------------------------------------------------------

To jump to a specific page

If you are revising a document that you have printed or repaginated, you can quickly 
move to the first character on a specific page with the Edit Go To command. This 
command is especially useful if the document is very long.

1. Choose Edit Go To (ALT, E, G).
2. In the Go To box, type the number of the page you want to jump to.

Word shows the current page number on the status bar.
To jump to the beginning of the last page, you can type a number you 

know is higher than the last page number.



3. Choose OK (ENTER).

NOTE____________________________________________________________
If automatic pagination isn’t turned on, and if you’ve made changes and haven’t 
repaginated or printed, Edit Go To may not work. You need to turn on the Background 
Pagination check box in the Utilities Customize dialog box, or use the Utilities 
Repaginate Now command.

If your document has multiple sections, you may have more than one page with the 
same number. You can go to a specific page in a section by typing the page number, 
then s and the section number. For example, type 12s4 to go the page 12 in the fourth 
section.
_________________________________________________________________

MACRO HINT______________________________________________________
To go quickly to the beginning of the next or previous page, you can use the supplied 
macros next_page and prev_page.
_________________________________________________________________

Selecting Text

Before you can use some Word commands, such as Edit Copy, Edit Cut, and Format 
Character, you must first select the text you want to work with. When you select text, 
Word highlights that text by displaying it in reverse video (black or colored text on a 
white background). Selected text is always highlighted.

You can use keys or the mouse to select any amount of text you want—a character, a 
word, a sentence, a paragraph, a column, or the entire document. You can also extend 
a selection forward or backward in the document.

The following definitions clarify the terms used for selecting text:

This term Refers to
---------------------------------------------------------------------------------------------------------
Character Any letter, number, symbol, or punctuation mark.
Word Any group of characters separated by spaces, tabs, 

hyphens, or punctuation. A word includes all trailing 
spaces. (A trailing space is created by pressing 
SPACEBAR after a word.) Each punctuation mark
with its trailing space is also considered a word.

Sentence Any group of characters before and including 
sentence-ending punctuation (period, question 
mark, or exclamation point), along with the trailing
space. If you imbed a period, question mark, or 
exclamation point between characters (with no trailing
space), Word does not treat the punctuation as a 
sentence-ending punctuation.



Paragraph Any group of characters before, and including, a 
paragraph mark. The paragraph mark contains 
the formatting information for its paragraph.

Line Text stretching from the left margin to the right
margin, including a paragraph mark or newline
character if there is one.

Column Any rectangular block of characters. You can 
select a column, part of a column, or a series of 
columns.

Document The entire document, excluding footnotes and 
page numbers.

---------------------------------------------------------------------------------------------------------

Selecting Text with the Keyboard

To select text with the keyboard, first move to the text by using any of the keys listed in 
“Scrolling Through a Document,” earlier in this chapter.

You can use the extend key, F8, to select a unit of text (word, sentence, paragraph, or 
document) and extend your selection. You can also use key combinations to select a 
unit of text.

Using the Extend Key (F8) to Select Text

Pressing F8 turns on extend mode. After you turn on extend mode, you can press F8 
repeatedly to select progressively larger units of text in this order: a word, a sentence, a 
paragraph, and the entire document. Alternatively, once extend mode is turned on, you 
can use the direction keys to select any amount of text.

To select a word, sentence, paragraph, or document by using F8
1. Press F8

EX (for extend mode) is displayed in the status bar.
2. Press F8 until the amount of text you want is selected.
3. Press ESC to exit extend mode.

NOTE____________________________________________________________
You can select a sentence by pressing F8 followed by the PERIOD key, and select 
additional sentences by pressing the PERIOD key repeatedly. You can select the next 
occurrence of a letter by pressing F8 and then typing the letter you want to select. For 
example, with your cursor under the first s, in the word success, you select to the end of
the word by pressing F8 and then pressing the letter s twice.
_________________________________________________________________

To reduce a selection made by using F8
* Press SHIFT+F8 until the amount of text you want is selected.



SHIFT+F8 reduces the selection one unit at a time—from whole document to 
paragraph, paragraph to sentence, and sentence to word.

To select any amount of text by using F8
1. Press F8.

EX (for extend mode) is displayed in the status bar.
2. Use the direction keys to select the amount of text you want.

To turn off extend (F8)
* Press ESC.

Word automatically turns off extend when you carry out most commands, type a 
character, split or close a window, or make another window active.

NOTE____________________________________________________________
Certain keys, such as INS and DEL, and the CTRL+SHIFT+key combinations for speed 
formatting also turn off extend. Edit Search and Edit Go To do not turn off extend. 
Instead, you can use these commands to extend your selection quickly over a range of 
text ending with the text, page, bookmark, footnote, or annotation you designate.
_________________________________________________________________

Using Key Combinations to Select Text

There are two ways to select a unit of text using key combinations: you can select a 
specific unit of text, or you can select backward or forward from the cursor.

To select a unit of text

The following table lists the key combinations that select a single unit of text (word, line, 
sentence, paragraph, or document). If you use one of these key combinations and then 
repeat it, Word selects the next unit of text. For example, you select the current word by 
pressing ALT+F6, and the next word by pressing ALT+F6, ALT+F6.

To select Press
---------------------------------------------------------------------------------------------------------
Word ALT+F6
Sentence ALT+F8
Paragraph ALT+F10
Document CTRL+5(on numeric keypad)
---------------------------------------------------------------------------------------------------------

To select text from the cursor location

The following table lists the key combinations that select a unit of text (word, line, 
sentence, and so forth), from the cursor location.



If you use one of these key combinations and immediately repeat it, Word extends the 
selection to the next (or previous) unit of text. (The functions marked with * are 
exceptions.)

NOTE____________________________________________________________
If you are selecting from left to right (forward), the character at the cursor location is 
selected first. If you are selecting from right to left (backward), the selection begins at 
the character to the left of the cursor.
_________________________________________________________________

To extend Press
---------------------------------------------------------------------------------------------------------
Forward one character at a time SHIFT+RIGHT ARROW
Backward one character at a time SHIFT+LEFT ARROW
Forward through the end of the current word CTRL+SHIFT+RIGHT ARROW
Backward through the beginning of the current 
word CTRL+SHIFT+LEFT ARROW
Through the current line* HOME, SHIFT+END
Up one line SHIFT+UP ARROW
Down one line SHIFT+DOWN ARROW
Forward through the last character in the 
current line* SHIFT+END
Backward through the first character in the 
current line* SHIFT+HOME
Through the current sentence F8, PERIOD 

(To repeat, press PERIOD only. 
To turn off extend mode, press 
ESC.)

Forward through the current paragraph CTRL+SHIFT+DOWN ARROW
Backward through the current paragraph CTRL+SHIFT+UP ARROW
Down one screen SHIFT+PGDN
Up one screen SHIFT+PGUP
Forward through the last character in the document* CTRL+SHIFT+END
Backward through the first character in the document* CTRL+SHIFT+HOME
---------------------------------------------------------------------------------------------------------

HINT_____________________________________________________________
When you extend a selection with an ARROW key combination, think of the left edge of 
the cursor as the anchor point for the selection. You expand the selection by moving 
away from the anchor point, and reduce the selection by moving toward the anchor 
point. For example, you select the character to the right of the cursor using 
SHIFT+RIGHT ARROW. Then, to select the character to the left of the cursor, you press
SHIFT+LEFT ARROW once to return to the cursor location (the anchor point), and 
press SHIFT+LEFT ARROW again to select the character.
_________________________________________________________________

Selecting Text with the Mouse



To select text with the mouse, first move to the text using any of the actions listed in 
“Scrolling Through a Document, “ earlier in this chapter.

To select a word, line, sentence, paragraph, or document

The selection bar is an unmarked column at the far-left edge of each window, between 
the text and the border. If you’re in graphics mode, the pointer slants toward the right 
when it’s in the selection bar, instead of toward the left as it otherwise does. You use the
mouse in the selection bar to select a line, a paragraph, or your whole document.

To select Do this
---------------------------------------------------------------------------------------------------------
Word Position the mouse pointer in the word and double-click the

left mouse button.
Line Position the mouse pointer in the selection bar and click 

the left mouse button.
Sentence Position the mouse pointer in the sentence, hold down CTRL, 

and then click the left mouse button.
Paragraph Position the mouse pointer in the selection bar and double-click 

the left mouse button.
Entire document Position the mouse pointer in the selection bar, hold down 

CTRL, and then click the left mouse button.
---------------------------------------------------------------------------------------------------------

To select text
Method 1

1. Position the mouse pointer at the beginning or end of the text you want to 
select.
2. Hold down the left mouse button, drag the pointer to the other end of the 
text, and then release the mouse button.

Method 2
1. Position the mouse pointer at the beginning or end of the text you want to 
select and click the left mouse button.
2. Without holding down the mouse button, move the mouse pointer to the 
opposite end of the selection.
3. Hold down SHIFT and click the left mouse button.

Selecting a Column

Selecting a column in a table is similar to extending a selection in that you start with a 
single character that anchors the selection. You can select either a single column or a 
block of text containing multiple columns. For example, you can only select the numbers
in a numbered list.

To select a column



1. Move the cursor the character in the upper-left corner of the column you 
want to select.
2. Press CTRL+SHIFT+F8 to turn on column selection.

CS appears in the status bar at the bottom of your screen.
3. Press the direction keys of position the mouse pointer and click to extend 
the selection.
4. Press CTRL+SHIFT+F8 to turn off column selection.

After some commands, such as File Print and File Open, Word automatically turns off 
column selection.

When column selection is turned on, some Word commands will not be available. For 
example, Format Margins and Format Section are not appropriate for a column. If you 
choose one of these commands, Word displays a message telling you it is not a valid 
action for column selection.

Choosing Commands

A command tells Word what you want to do next—work with files, edit text, change the 
way your document is displayed on the screen, and so on.

The menu bar, at the top of the Word screen, organizes commands in menus. 
Commands that carry out similar actions are grouped in one menu. For example, the 
commands you use to work with files—to create a file, to save a file, and to print a file—
are all located in the File menu.

Selecting a menu from the menu bar displays a list of commands to choose from. You 
can choose a command using either the keyboard or the mouse.

If a command is followed by an ellipsis (...), it displays a dialog box when you choose it. 
You use a dialog box to supply information that Word needs to carry out the command. 
For information about using dialog boxes, see “Using Dialog Boxes,” later in this 
chapter.

If a command is not followed by an ellipsis, it doesn’t display a dialog box and Word 
carries out the command immediately.

NOTE____________________________________________________________
If a command name in a menu is followed by a key combination, you can quickly 
choose the command (without activating the menu bar) by pressing the keys indicated. 
If you don’t want to see the key combinations in your menus, you can simplify your 
menu display using the Utilities Customize command. For more information on Utilities 
Customize, see Chapter 3, “The Word Screen.”
_________________________________________________________________



Some commands, such as View Ruler, toggle. This means that you choose the 
command once to turn it on, and then choose it again to turn it off. When a toggle 
command is turned on, there is a mark beside it in the menu.

NOTE____________________________________________________________
If a menu or command doesn’t apply to what you are doing, you won’t be able to choose
it.
_________________________________________________________________

To choose a command
KEYBOARD

1. Press ALT to activate the menu bar.
One letter in each menu name becomes bold. (The bold letter is 

sometimes called the accelerator key.)
2. Press the bold letter of the menu you want.

Word displays the commands on that menu.
3. Press the bold letter of the command you want.

MOUSE
1. Point to the name of the menu you want to select and click the left mouse 
button. 
Word displays the commands on that menu.
2. Point to the name of the command you want to choose and click the left 
mouse button.

NOTE____________________________________________________________
If you want more room to view text on the screen, you can hide the menu until you’re 
ready to use it. For more information about changing the way your screen looks, see 
Chapter 3, “The Word Screen.”
_________________________________________________________________

Browsing Through Menus and Commands

When you select a menu name in the menu bar or a command name in a menu, Word 
describes it in the message bar at the bottom of the screen. You can view a brief 
description of each menu and command by browsing through the menus and 
commands.

To browse
KEYBOARD

1. Press ALT.
2. Press RIGHT ARROW and LEFT ARROW  to move from one menu to 
another.
3. Press UP ARROW and DOWN ARROW to move through the commands 
in a menu.
4. To stop browsing and cancel a menu, press ESC.

MOUSE
1. Hold down the left mouse button.



2. Move the mouse pointer over the menu and command names.
3. To stop browsing and cancel a menu, drag the mouse pointer off the 
menu, and then release the mouse button.

Using Dialog Boxes

When you choose a command name followed by an ellipsis (...), Word displays a dialog 
box. In a dialog box, you specify exactly how you want the command carried out, and 
then choose a button to have Word complete the command.

Responses are always proposed for you in a dialog box; you change only the options 
you want. If you make a mistake, you can make a different choice or type the correct 
information. If you’ve chosen a command by mistake, you can cancel the dialog box 
without carrying out the command.

All Word dialog boxes use one or more of these five options
* Text box
* Option box
* Check box
* List box
* Command buttons

To select an item in a dialog box

The following information summarized the keys and mouse actions you use to work with
dialog boxes. For more information on each type of dialog box option, see the 
appropriate section later in this chapter. (The functions marked with * are 
exceptions.)

Method 1
KEYBOARD:
To Press
---------------------------------------------------------------------------------------------------------
Move to an option and select it ALT+the bold letter or number
Select an item in a list box DIRECTION keys
Complete the command ENTER
Cancel the dialog box ESC
---------------------------------------------------------------------------------------------------------
Method 2
To Press
---------------------------------------------------------------------------------------------------------
Move forward from one option to the next TAB
Move backward to the previous option SHIFT+TAB
Turn check boxes on and off SPACEBAR
Select an option in an option box DIRECTION keys
Carry out the command button* ENTER
---------------------------------------------------------------------------------------------------------



NOTE____________________________________________________________
An active button is indicated by bold brackets; pressing ENTER carries out whichever 
command button is active. To choose a command if the command button is not active, 
you must first press TAB until the command is selected.
_________________________________________________________________

MOUSE:
* Point at the option with the mouse pointer and click the left mouse button.

Editing a Text Box

In a text box, you can type new information or edit existing information, much as you do 
in a document. When you move to a text box, the characters in the text box are 
automatically selected. Whatever you type replaces the text in the selection. 

If there is no selection in the text box, text is inserted at the cursor position. The text box
scrolls to the right, if necessary, to show your text as you type.

To edit text

To Do this
---------------------------------------------------------------------------------------------------------
Move to a text box and select the text Hold down ALT and press the option’s 

bold letter, or point to the box and click 
the left mouse button.

Replace a selection Type.
Move the cursor Press RIGHT ARROW, LEFT ARROW, 

HOME, or END, or point to the new 
location and click the left mouse button.

Select text Hold down SHIFT and press RIGHT 
ARROW, LEFT ARROW, HOME, or 
END, or hold down the left mouse 
button and drag to extend the selection.

Delete text Press BACKSPACE or DEL.
Change a selection Press RIGHT ARROW or LEFT 

ARROW and make a new selection, or
make another selection with the mouse.

---------------------------------------------------------------------------------------------------------
Selecting an Item in a List Box

A highlight indicates the selected item in a list. If there are more items in a list than you 
can see at one time, you can scroll to see the rest. For complete information on 
scrolling, see “Scrolling Through a Document,” earlier in this chapter.

To select an item in a list



1. Hold down ALT and press the bold letter of the option you want.
2. Do any of the following:

To Do this
---------------------------------------------------------------------------------------------------------
Select the next item in the list vertically Press UP ARROW, DOWN ARROW, 

HOME, END, PGUP, or PGDN, or scroll 
and click the left mouse button.

Select the next item in the list horizontally Press RIGHT ARROW or LEFT 
ARROW, or scroll and click the left 
mouse button.

Select the item in a list that begins 
with a particular letter Press the letter you want. 

If there is more than one item that 
begins with that letter, continue pressing
the letter until that item is selected.

Select an item in a list and close the 
dialog box Point to the item and double-click the 

left mouse button.
---------------------------------------------------------------------------------------------------------
Using a Drop-Down List

Sometimes, a text box and a list box are combined to create a drop-down list. In a drop-
down list, you select an item from the list.

Some drop-down lists also let you type in the text box. You move to the text box in a 
drop-down list and type your response just as you would with any text box. For more 
information, see “Editing a Text Box,” earlier in this chapter.

To select an item from a drop-down list
KEYBOARD:

1. Press ALT+the bold letter in the list box name.
2. Press ALT+DOWN ARROW.
3. Press UP ARROW or DOWN ARROW.
4. Press ALT+DOWN ARROW or F4 to close a drop-down list.

MOUSE:
1. Click the arrow with the left mouse button.
2. Scroll, if necessary, to see the item in the list.
3. Click the left mouse button on an item in the list.

Selecting an Option Button

A mark beside an option means that it is selected. Option buttons occur in groups; each 
group of buttons is displayed in an option box. At any one time, only one option in an 
option box can be selected.



Some options reflect the formatting of selected text. For example, if you select a 
paragraph with right alignment and choose Format Paragraph, the Right option is 
selected in the dialog box. However, if you select two paragraphs with different 
formatting—one with right alignment and one with left alignment, for example—Word 
won’t select an option button; all the option buttons in the Alignment option box will be 
blank.

To select an option button
* Hold down the ALT key and press the bold letter of the option you want, or point to 
the option and click the left mouse button.

Turning a Check Box On or Off

When a check box is turned on, an X appears in the check box to the left of the option. 
Any combination of check boxes can be on at the same time. For example, you can turn
on both the Bold and Italic check boxes in the Format Character dialog box to make a 
selection both bold and italic.

Some check boxes reflect the formatting of selected text. For example, if you select text 
formatted as italic, the Italic check box will be turned on in the Format Character dialog 
box.

If a selection in your document contains a mixture of options, a check box may contain a
dash. For example, if a selection contains one paragraph in italics and another 
paragraph in normal text, the Italic check box in the Format Character dialog box 
contains a dash to indicate this mixture of settings.

To turn a check box on or off
* Hold down ALT and press the bold letter of the option you want, or point to the 
option and click the left mouse button.

Using Command Buttons

After you set all the options in a dialog box, you choose a command button to act on 
those options. The label on a command button describes the action that will be taken 
when the button is chosen.

Many dialog boxes have just two buttons, OK and Cancel. The OK button, the default 
button, is shown with bold brackets. Choosing the default button carries out the 
command. Choosing the Cancel button removes the dialog box without carrying out the 
command.

Many dialog boxes contain command buttons in addition to OK and Cancel. For 
example, the File File Management dialog box contains one button to copy a file and 
another to delete a file. If the name on a command button is followed by an ellipsis (...), 
choosing the button opens another dialog box related to the command. 



Some dialog boxes, such as the Spell dialog box, have a Close button instead of a 
Cancel button. Changes you make in the dialog box are carried out immediately. You 
can’t cancel these changes, but you can choose Edit Undo immediately on return to 
your document to undo the most recent change.

A few dialog boxes don’t contain an OK button. In these dialog boxes, choosing a 
command button either opens another dialog box or immediately carries out the 
command, closes the dialog box, and returns you to your document.

To Choose a Command button
Do any of the following:

* Hold down ALT and press the bold letter of the option you want.
* Press TAB (if necessary) until the command has bold brackets, then press 
ENTER.
* Point to the command button and click the left mouse button.

HINT_____________________________________________________________
Double-clicking an item in a list has the same effect as choosing OK. Double-clicking in 
the Files list in the File Open dialog box carries out the File Open command and 
automatically closes the dialog box. Double-clicking in the Directories list in the File 
Open dialog box updates the Files list to show the files in that directory.
_________________________________________________________________

To cancel a dialog box
* Press ESC, or point to the Cancel button and click the left mouse button.

Repeating a Command

You can repeat the following commands:
* File New and File Open
* Edit Repeat, Edit Cut (or the SHIFT+DEL combination), Edit Copy, Edit Paste (or 
the SHIFT+INS key combination), Edit Search, and Edit Replace
* Insert Break, Insert Footnote, Insert File, Insert Annotation, and Insert Picture
* Format Character, Format Paragraph, Format Section, Format Margins, Format 
Tabs, Format Borders, Format Position, Format Header/Footer, Format Apply Styles, 
and Format Record Styles
* Utilities Spelling, Utilities Thesaurus, Utilities Hyphenate, Utilities Word Count, 
Utilities Sort, and Utilities Calculate
* Macro Run and Macro Edit
* Window New Window
If you repeat Edit Replace, Utilities Spelling, Utilities Thesaurus, or Utilities Hyphenate, 
Word displays the dialog box, rather than repeating the command.

You can repeat all of these commands, except Edit Replace and Edit Search, by 
following the procedure below.



To repeat a command
* Press F4 before you take any other action (except moving the cursor).

NOTE____________________________________________________________
Selecting a glossary item and pressing F3 inserts text from the glossary associated with
the glossary item. If you press F4 after pressing F3, Word inserts the glossary text 
again, even if a glossary item isn’t selected.
_________________________________________________________________

Example

The following example describes how you might use Word’s ability to repeat a 
command to format headings in several places in a document.

Suppose that after typing a short memo, you decide that several subject headings 
should be in bold type. The heading should be separate paragraphs.

1. Select the first heading paragraph you want to format.
2. Format it as you normally would, using the Format Character command or 
speed formatting keys.
3. Select the next heading you want to format.
4. Press F4 to repeat the formatting.
5. Repeat steps 3 and 4 for all remaining headings you want to format the 
same way.

NOTE____________________________________________________________
Instead of selecting each heading and repeating the formatting, you may want to apply 
styles that format all of your headings at one time.
_________________________________________________________________

About Word Messages

Word displays information about your Word session in the message bar at the bottom of
the screen. If a situation occurs that requires immediate action, a message is displayed 
in a box in the center of your screen.

A message may contain buttons to let you choose different actions. When buttons are 
displayed in a message box, they work in the same way as buttons in a dialog box. 
Press the appropriate key for the choice you want, or click your choice with the left 
mouse button.

NOTE____________________________________________________________
Choosing Retry in a message box directs Word to attempt to complete the process that 
originally caused the message to appear.  If choosing Retry results in the same 
message, press ESC to cancel the message box and correct the situation that caused 
the message before continuing.
_________________________________________________________________



If you need to find out more about a message, press F1 to get online help about the 
message.



Chapter 3: The Word Screen

Overview

This chapter describes the parts of the basic Word screen, which you use for most of 
your work in Word. You can customize the appearance of the screen to suit your needs. 
For example, to help you format your text, you can show nonprinting characters, such 
as paragraph marks, that are by default not displayed. You can turn on the ruler to 
check paragraph indents and the formatting ribbon to check the style you’ve applied to a
selection. You can also turn off some of the elements on the screen, such as the 
message bar, to view more lines of text.

The basic Word screen can contain up to nine windows. A window is the area of the 
Word screen where text is displayed. You can open a window to type and edit your 
document, or open other windows—such as a style sheet window—to perform other 
tasks with Word.

The Basic Word Screen

When you first start Word, you see the basic Word screen including the following.

Menu Bar

In Word, you revise and format a document by choosing commands from the menu bar. 
Related commands are arranged on the same menu. For example, the commands you 
use to open, close, save, and print files are located on the File menu; the commands 
you use to delete, insert, and search for text are on the Edit menu. Using the menu bar 
is discussed in detail in Chapter 2, “Scrolling, Selecting Text, and Choosing 
Commands.”

Message Bar

The message bar displays information about your Word session—by telling you when 
Word is printing, paginating, or saving a document, for example. The message bar also 
tells you how to choose a command, and it describes the command you’ve chosen.

Status Bar

The status bar displays information about your Word session and about the document 
you’re working on.

Page, section, column, and line numbers

These indicators tell you where the cursor is located in the document. The page number
shows which page the cursor is on.



If there is more than one section in the document, the section number shows which 
section the cursor is in.

The column number shows the current horizontal position of the cursor on the screen, 
counting from the left margin.

If the Show Line Numbers check box is turned on in the View Preferences dialog box, 
the line number is displayed on the status bar. The line number shows the number of 
the line on the screen that contains the cursor, counting down from the last page break.

Scrap { }

The scrap displays the text that you most recently copied or deleted. An ellipsis (...) 
indicates that the text is longer than the space available in this portion of the status bar.

<F1=Help>

When you press F1 or click this location with the left mouse button, Word displays 
information about the command you are currently working with.

Key status

The key status reminds you that you have turned on one or more of the following 
functions, which are represented on the screen by two-letter abbreviations:

Abbreviation Key/command/option Meaning
---------------------------------------------------------------------------------------------------------
CL CAPS LOCK Typing letters enters capitals
CS CTRL+SHIFT+F8 Select column(s)
EX F8 Extend the selection
OT INS Type over text (overtype)
LD Utilities Line Draw Draw lines
LY View Layout View page layout
MR CTRL+F3 Record a macro
MX CTRL+F10 Maximize the window
NL NUMLOCK Keypad keys enter numbers
RM Utilities Revision Marks Mark revisions
SL SCROLL LOCK Direction keys scroll
ST Step check box in Macro Run dialog 

box Step through a macro
---------------------------------------------------------------------------------------------------------

NOTE____________________________________________________________
If you have more than one of these functions turned on, the codes appear next to each 
other on the status bar. Some codes—LD and NL, MX and SL, RM and OT, LY and CL, 
CS and EX—share one position on the status bar. In these cases, LD, MX, RM, and LY  



have precedence over NL, SL, OT, and CL, respectively. CS and EX share the same 
position, but only one can be on at any time. Whichever is on shows on the status bar.
_________________________________________________________________

The Window

On the screen, Word displays a window for each document you create.

You can open as many as nine windows at a time. Each window overlaps the previous 
window on the screen.

To view more than one window at a time, you can size, move, and arrange your 
windows. You can also divide a window into two smaller windows, or panes. Each pane 
can display any part of the open document. 

If you have a mouse, you use the window icons to size, split, and close the window, and
to display the ruler and formatting ribbon. If you don’t have a mouse, you use 
commands from the Window menu to size, split, and close a window, and commands 
from the View menu to display the ruler and formatting ribbon.

Window border

The border that separates the document from the rest of the screen.

Title bar

The title bar displays the name of the active document. Before you save a document, it 
is called Documentx, where x is a number beginning with one and increasing by one for 
each document opened. If you have a mouse and more than one window on the screen,
you can drag the title bar to move the top window to display more of the window 
beneath.

Scroll bars

Scroll bars let you scroll through the document to see parts that weren’t previously 
visible. Scroll bars scroll proportionately with the document, so you can see where you 
are in relation to the top, middle, and bottom of the document. If you have a mouse, you
can use the scroll bars to scroll quickly through a document. For more information about
scrolling, see Chapter 2, “Scrolling, Selecting Text, and Choosing Commands.”

Icons

If you have a mouse, you can use the icons in the window border to carry out specific 
actions:

Use the Icon that Does this



Sizes Enlarges and reduces the window
Maximize Enlarges the window to fill the screen
Split Splits the window into two panes
Close Closes the window
Ruler and formatting ribbon Turns the ruler and ribbon on and off

Selection bar

The leftmost column of the window contains the selection bar. If you have a mouse, you 
can click in the selection bar to quickly select a line, paragraph, or the whole document. 
For more information about using the selection bar, see Chapter 2, “Scrolling, Selecting 
Text, and Choosing Commands.”

Endmark

The endmark indicates the end of your document. You can’t edit or delete an endmark.

Style bar

If you use a style sheet for formatting, you can turn on the style bar to view the 
formatting styles you’ve applied to your text. Although you can use the formatting ribbon
to view the style of the selected paragraph, the style bar lets you view the formatting for 
all paragraphs and sections at the same time.

Customizing the Word Screen

You can customize the Word screen to suit your personal preferences. Using 
commands on the View menu, you can:
* Change the way text is displayed on your screen.
* Add the ruler to display the tabs and indenting of a selected paragraph.
* Add the ribbon to display the character formatting of selected text.
* Show nonprinting characters, such as paragraph marks and hidden text.
* Show line breaks as they will occur during printing.
* Show line numbers.
* Remove the status bar, message bar, menu bar, scroll bars, and window borders to 
display more text in the window. You can also remove the key combinations from the 
menus to simplify your screen (this option is in the Utilities Customize dialog box).
* Change the window background color, colors that distinguish elements on your 
screen (such as the menu bar, dialog boxes, and scroll bars), and colors that distinguish
different character formats.

You can adjust the speed of the cursor in the View Preferences dialog box, or by turning
off cursor blinking at the DOS prompt. You can also turn off the beep that Word uses to 
alert you to errors (this option is in the Utilities Customize dialog box).

NOTE____________________________________________________________



When you exit, Word stores many of the changes you make to customize the screen. 
When you start Word again, these choices are still in effect. The choices are stored in 
the file MW.INI, which you create when you run Setup. If you accidentally delete MS.INI,
Word recreates the file using the default settings.
_________________________________________________________________

Changing Your View of the Text

You choose commands from the View menu to determine the way Word displays text on
your screen. The commands listed in the following procedure toggle. This means that 
you choose the command once to turn it on, and then choose it again to turn it off. 
When a toggle command is turned on, it has a mark beside it in the menu.

NOTE____________________________________________________________
Switching between graphics mode and text mode is an additional way to change how 
Word displays text on your screen. Text mode provides maximum speed and efficiency 
in editing, and, if you have a color monitor, shows character formatting in color. 
Graphics mode shows character formatting as it will look when printed. For example, in 
text mode italic text is blue by default, while in graphics mode the same text is displayed
in italics on the screen.
_________________________________________________________________

To change your view of the text
1. Select the View menu (ALT, V).
2. Do one of the following:

Choose For
Layout Viewing side-by-side columns and the position of objects

on the page
Outline Viewing your text in outline form

Displaying the Ruler

The ruler displays the paragraph indents and tab stops in the paragraph that contains 
the cursor.

If you move the cursor to a differently formatted paragraph, the ruler display changes to 
show the formatting of the selected paragraph. If you select two or more paragraphs 
that have different formats, the ruler shows the formatting for the tab settings common 
to the paragraphs.

Each document window can contain a ruler. You can even have the ruler on in one pane
of a split window and off in another. When you exit Word, if the ruler is on in the last 
window you opened, the ruler will be on the next time you start Word.

To turn the ruler on and off
KEYBOARD:
* Choose View Ruler (ALT, V, R).



MOUSE:
* Point to the ruler icon (^) in the upper-right corner of the window and click the left 
mouse button.

If you have a mouse, you can change paragraph indents and set, insert, and delete tab 
stops on the ruler. If you don’t have a mouse, use the Format Paragraph command to 
change indents and the Format Tabs command to change tab stops. You can also press
CTRL+SHIFT+F10 to move the cursor to the ruler and make changes to tab stops.

Displaying the Ribbon

The ribbon displays the font name, size, and character formatting (bold, italic, 
underlined) of the selected text. If a style sheet is attached to your document, the ribbon
shows the style of the selection.

The ribbon shows the formatting of the selected text, unless the selected text contains 
different formats. If a selection contains different character formats (for example, one 
bold word and one italic word), question marks appear next to the corresponding 
abbreviations on the ribbon. If the selection includes paragraphs formatted with different
styles, the Style I.D. box on the ribbon is blank.

To turn the ribbon on and off
KEYBOARD:
* Choose View Ribbon (ALT, V, B).
MOUSE:
* Point to the ruler icon in the upper-right corner of the window, and click the right 
mouse button.

If you have a mouse, you can apply styles, fonts, sizes, and character formatting on the 
ribbon. If you don’t have a mouse, use the Format Apply Style command to apply styles 
from the style sheet and the Format Character command to change the font, size, and 
character formatting. You can also press CTRL+S, CTRL+P, and CTRL+F to move to 
the ribbon and make changes to styles.

Showing Nonprinting Characters

The Word window is designed to give you an accurate preview of the characters and 
paragraphs in a printed document. For this reason, Word initially does not display 
symbols for tab characters, paragraph marks, spaces, and other nonprinting characters.

Sometimes, however, you’ll find it helpful to see these symbols and text, such as when 
you are formatting paragraphs and need to see where the paragraphs end, or when 
you’ve used hidden text to add personal notes to your document.

To show nonprinting characters
1. Choose View Preferences (ALT, V, E).



2. In the Non-Printing Characters box, turn on the check box for each type of 
character you’d like to see:

To see Turn on this check box
Tabs, optional hyphens, 
paragraph marks, newline 
characters, spaces, nonbreaking
spaces, and hidden text. In graphics 
mode, hidden text is displayed with a 
dotted underline. Show All

Tab characters. Tabs

Optional hyphens. Optional Hyphens

Paragraph marks and newline 
characters. If paragraph marks are 
chosen, and hidden text is not chosen, 
a double arrow marker indicates 
hidden text. Paragraph Marks

Spaces displayed as dots halfway up 
the height of the line. Nonbreaking 
spaces are blank. Spaces

Hidden text displayed with a dotted 
underline in graphics mode. Hidden Text

3. Choose OK (ENTER).

NOTE____________________________________________________________
To view hidden text in layout view, you must turn on the Hidden Text check box in the 
File Print Options dialog box. To print hidden text, you must choose the File Print 
command, choose the Options button, and turn on the Hidden Text check box.
_________________________________________________________________

Showing Line Breaks

Normally, Word breaks the lines on the screen so that each line is fully visible in the 
window. If you choose to show line breaks, Word breaks the lines where they will be 
broken on the printed page. Depending on the font and size you’re using and the 
margins you’ve set, lines may be carried past the right edge of the window, requiring 
you to scroll horizontally to see the end of a line.



It is more convenient to work without showing line breaks because you don’t have to 
scroll horizontally to see all your text. If you are printing 12-point (10-pitch) characters in
a fixed-width (monospace) font, line breaks are the same on the screen as in the printed
output. If you are using a proportional font and/or a font other than 12-point (10-pitch), 
line breaks on the screen will match your printed output if you turn on the Line Breaks 
check box in the View Preferences dialog box.

To turn line breaks on and off
1. Choose View Preferences (ALT, V, E).
2. Turn Line Breaks on or off.
3. Choose OK (ENTER).

NOTE____________________________________________________________
Word automatically shows line breaks when you choose the Utilities Repaginate Now 
command and turn on the Confirm Page Breaks check box. To preview the document’s 
formatting and page layout, use the File Print Preview command.
_________________________________________________________________

Showing Line Numbers

Line numbers are useful if you are preparing a legal brief or other document where you 
need to refer to specific lines of text. On the status bar, the line number shows the 
number of the line on the screen that contains the cursor, counting down from the last 
page break. You use the View Preferences command to view line numbers on the 
screen, and the Format Section command to include line numbers when you print the 
document.

To turn line numbers on and off
1. Choose View Preferences (ALT, V, E).
2. Turn Show Line Numbers on or off.
3. Choose OK (ENTER).

Displaying More Text on the Screen

You can display additional lines and columns of text in the window by removing:
* The status bar
* The menu bar
* The style bar
* The scroll bars and window borders
* The message bar

You can also display additional lines by turning off the ruler and formatting ribbon, if you 
have turned them on. For more information about the ruler and ribbon, see “Displaying 
the Ruler,” and “Displaying the Ribbon,” earlier in this chapter.

NOTE____________________________________________________________



To turn off window borders, you must first choose Window Maximize (ALT, W, X).
_________________________________________________________________

To display more text on the screen
1. Choose View Preferences (ALT, V, E).
2. Turn off the screen elements you want to remove:

To remove the Turn off the
Menus Menu check box
Horizontal scroll bar Horizontal check box
Vertical scroll bar Vertical check box
Message bar Message Bar check box
Window borders Window Borders check box
Style bar Style Bar check box

3. If your video setup allows you to do so, you can also select a display 
mode, in the Display Mode box, that shows additional lines of text on your screen
instead of the usual 25.
4. Choose OK (ENTER).
5. If the status bar is on, there is a mark beside the Status Bar command on 
the View menu. To turn off the status bar, choose View Status Bar.

NOTE____________________________________________________________
If the menu bar is off, you can still view the menu names and commands by pressing 
ALT.
_________________________________________________________________

Turning off the message bar, status bar, and menu bar each lets you view one additional
line of text in the window.

Turning off the scroll bar, window borders, and style bar at the same time increases the 
text area by two lines and two columns. You can turn off scroll bars and borders 
independently of each other; because they occupy the same space, however, turning off
only one or the other won’t increase the text area.

You can remove the scroll bars at any time. However, you can remove window borders 
only if the Window Maximize command is chosen and there is one full-sized window 
showing on the screen. If you open a second window while you have one window 
without borders showing on the screen, the second window will be full-sized and its 
borders will be off.

NOTE____________________________________________________________
If you want to use the mouse to size, move, and scroll through windows, the window 
borders and scroll bars must be turned on. If the window borders and scroll bars are off,
use the Window and File commands to work with windows, or use the View Preferences
command to turn the borders and scroll bars on again.
_________________________________________________________________



To remove key combinations from the menus
1. Choose Utilities Customize (ALT, U, U).
2. Turn off the Show Keys On Menus option.
3. Choose OK (ENTER).

Changing Window Colors

When you run Setup, you identify the type of monitor and graphics card you are using, 
and Word assigns the default color set appropriate for your hardware. You can use the 
View Preferences command if you want to change the colors assigned to the window 
background, title bar, and other areas on the screen. You can also assign colors to 
character formats and make it easier to distinguish them as you’re working.

NOTE____________________________________________________________
If you have a CGA card, you can change colors only in Word’s text mode. In graphics 
mode, the screen is black and white. If you choose the Color button in the View 
Preferences dialog box and don’t see colors, switch from graphics to text mode by 
choosing a Text setting in the Display Mode box. When you choose the Colors button in 
the View Preferences dialog box again, the color choices are displayed.
_________________________________________________________________

To change window colors
1. Choose View Preferences (ALT, V, E).
2. Choose the Colors button.
3. In the Things to Color box, select the name of the screen area you want to
change colors for.

Note that in the Things To Color box, items are listed by priority rather than
alphabetically. In the list, Accelerator Keys refers to the bold letters you see in the
menu bar when you press ALT.
4. Select the letter next to the color you want.
5. Repeat steps 3 and 4 to change colors for all the screen areas you want to
change.
6. Choose OK (ENTER).

NOTE____________________________________________________________
To return to the default color for a screen area, select the name of the screen area in the
Things To Color box and choose Ignore. The default applied is the default appropriate to
your hardware. For example, the defaults appropriate to a 16-color monitor are in Color 
Set 1, and the defaults appropriate to an 8-color monitor are in Color Set 2. To identify 
the default color set for your monitor, see the table under step 3 in the following 
procedure, “To reset window colors.”
_________________________________________________________________

HINT_____________________________________________________________



If you have more than one document open on the screen, you can easily identify each 
window by making it a different background color.
_________________________________________________________________

To reset window colors

If you change the window colors and want to reset all of the colors to the default settings
for your hardware, choose the Colors button in the View Preferences dialog box and 
use the Color Set box.

1. Choose View Preferences (ALT, V, E).
2. Choose the Colors button.
3. In the Color Set box, select a default color set for your monitor:

If you have this hardware Choose this 
color set
16-color (shows bold letters when ALT is pressed) Color 1
8-color (doesn’t show bold letters when ALT is pressed) Color 2
Monochrome with 4 shades of gray Color 3
Monochrome monitor (no gray shades) Monochrome
LCD (shows a square cursor, 
rather than a blinking underline) LCD

4. Choose OK (ENTER).

Changing the Cursor

You can control how fast your cursor moves by setting a speed from 1 through 9 in the 
View Preferences dialog box. Your cursor setting is saved when you exit Word; when 
you start Word again, the setting is still in effect.

To change cursor speed
1. Choose View Preferences (ALT, V, E).
2. In the Speed box, type a number from 1 through 9.

The slowest speed is 1; 9 is the fastest.
3. Choose OK (ENTER).

To turn off the cursor’s blinking

In Word, the cursor is a blinking underscore. When you start Word, you can choose to 
have a non-blinking underscore in graphics mode.
* To turn off the blinking cursor, type word/i at the system prompt.

If you turn off blinking and want to turn it back on, type word/z at the system prompt.

NOTE____________________________________________________________
You can adjust cursor blinking only in graphics mode, and only if you are running under 
DOS. You cannot adjust cursor blinking if you are running under OS/2.
_________________________________________________________________



Turning Off the Beep

Word alerts you to some errors—such as pressing a nonexistent key combination—by 
sounding a beep. You can turn off the beep in the Utilities Customize dialog box.

To turn off the beep
1. Choose Utilities Customize (ALT, U, U).
2. Turn on Mute.
3. Choose OK (ENTER).



Chapter 4: Getting Help

Overview

You can ask Word for online Help at any time by pressing F1. Help is context-sensitive, 
which means Word will automatically display the topic that is most appropriate for your 
current situation. You can get context-sensitive Help on any command, dialog box, or 
error message.

If Pressing F1
The cursor is somewhere in your document Gives you the Help Index
A menu command is highlighted Gives you Help about the command
A dialog box is displayed Gives you Help about the dialog box
A message is displayed Gives you Help about the message

You can browse the Help Index for categories of available topics, or choose Help 
commands from the menu for information about keyboard use, differences between 
Word, version 5.0, and Word, version 5.5, and Using Help.

Using Help

If you press F1 while the cursor is in your document or a menu command is selected, or
if you choose a Help menu command, a Help window opens. If you activate another 
window while the Help window is open, the newly active window covers the Help 
window. The Help window is listed on the Window menu; you can reactivate it by 
choosing ALT, W, H. You can arrange your windows to view Help and work in your 
document at the same time. For more information, see “To use Help while you work on 
your document,” later in this chapter.

If you press F1 to get help about a dialog box or message, Word opens a different kind 
of Help window, which you must exit by choosing ENTER or pressing ESC.

To get Help at any time
* Press F1.

To get Help on how to use Help
1. Choose Help Using Help (ALT, H, H).
2. Scroll through the information in the Help window, using UP ARROW, 
DOWN ARROW, PGUP, and PGDN, or using the mouse.
3. Choose Exit (ESC) to exit the Help topic, or press F1 to go to the Help 
Index.

Moving Around in Help: Indexes and Topics

When you choose Help Index, Help Keyboard, or Help Word 5.0 to 5.5, Word displays 
an index of topics. Each topic is enclosed in angle brackets (<>). You choose a topic 
from an index using any of the following methods:



* Press TAB to move forward from one topic to the next; press SHIFT+TAB to move 
backward. When the topic you want is selected, press ENTER.
* Type the first letter of the topic name; then press ENTER. If more than one item 
begins with that letter, continue pressing the letter until you’ve selected the topic you 
want.
* Point to the topic name and click the left mouse button.

Sometimes, a topic doesn’t provide all the information you need. Help topics contain 
jumps that let you move quickly to related topics.

Whenever you see a word or phrase in angle brackets, it means there is related 
information that you can jump to the same way you choose a topic from an index.

The first jump in a command topic usually takes you to a procedure associated with the 
command. The first jump in a procedure usually takes you to the command topic.

To get Help from an index of topics

You can browse the Help Index to find the topic you want.
1. Choose Help Index (ALT, H, I), or press F1 from the active window.
2. Choose a topic category.
3. Choose the topic you want to view.
4. Scroll through the information in the Help window, using UP ARROW, 
DOWN ARROW, PGUP, and PGDN, or using the mouse.
5. Press F1 to return to the Help Index, or choose Exit (ESC) to exit Help.

NOTE____________________________________________________________
You can always press F1 in a procedural or a command topic to return to the Help 
Index.
_________________________________________________________________

To get Help about keyboard functions

Word, version 5.5, has changed the actions that were associated with the INS and DEL 
keys and many function keys in Word, version 5.0. For a complete list of the new 
functions and the keys assigned to them:

1. Choose Help Keyboard (ALT, H, K).
Word displays the Keyboard Index.

2. Choose the topic you want to view.
3. Scroll through the information in the Help window, using UP ARROW, 
DOWN ARROW, PGUP, and PGDN, or using the mouse.
4. Do any of the following:

* Choose Keyboard to return to the Keyboard Index.
* Press F1 to go to the Help Index.
* Choose Exit (ESC) to exit Help.



NOTE____________________________________________________________
You can reassign keyboard actions to match Word, version 5.0, during Setup or by 
using the Utilities Customize command. However, F1 is now permanently assigned to 
Help; choosing Word, version 5.0, keys will not reassign F1 to its previous function 
(moving to the next window). If you are using the key assignments from Word, version 
5.0, use SHIFT+ALT+F1 to move the cursor to the next window.
_________________________________________________________________

To get Help if you are familiar with Word, version 5.0

If you are familiar with a command or a term in Word, version 5.0, that has changed for 
Word, version 5.5, you can use Help to find its equivalent. For example, you can look up
the new terminology that has replaced the Transfer Load command terminology from 
Word, version 5.0.

1. Choose Help Word 5.0 to 5.5 (ALT, H, 5).
Help lists Word changes by category.

2. Choose a cagegory.
3. Scroll through the information in the Help window, using UP ARROW, 
DOWN ARROW, PGUP, and PGDN, or using the mouse.
4. Do any of the following:

* Choose Word 5.0 to 5.5 to return to the Word 5.0 to 5.5 Index.
* Press F1 to go to the Help Index.
* Choose Exit (ESC) to exit Help.

To get Help about a command

When you choose a command from a menu, the message bar briefly describes the 
function the command performs. Selecting the command name and pressing F1 
provides more information about the command.

1. Press ALT to activate the menu bar.
2. Press the bold letter in the menu name containing the command.
3. Press DOWN ARROW until the command is selected.
4. Press F1.
5. Scroll through the information in the Help window using UP ARROW, 
DOWN ARROW, PGUP and PGDN, or using the mouse.
6. Choose Exit (ESC) to exit Help.

NOTE____________________________________________________________
You can also display the menu and highlight the command using the mouse. Hold down 
the left mouse button until after you press F1. If you release the mouse button before 
you press F1, you will choose the command instead of getting Help on it.
_________________________________________________________________

To look up the definition of a term
1. Choose Help Index (ALT, H, I).
2. Choose Definitions.



3. Choose the topic you want to view.
4. Choose OK (ENTER).

To get Help about a dialog box or message
1. With the dialog box or message displayed, press F1.
2. If there is more than one screen of information, view additional screens by 
pressing PGUP and PGDN or clicking the PgUp and PgDn buttons with the left 
mouse button.
3. Choose OK (ENTER).

To use Help while you work on your document

With Word’s Help system, you can view Help about a command as you work on a 
document. For example, you can read the Help procedure on inserting a footnote while 
you insert footnotes in your document.

1. Press F1 or use the Help Index to get the information you want.
2. Arrange the document and Help windows until they appear either side by 
side or above and below each other.

If you choose Window Arrange All, Word arranges our windows so they 
are all visible. If you have only one document window open, the document 
window is automatically displayed in the upper half of the screen and the Help 
window in the lower half.
3. Continue to work on your document and read the Help topic while you 
work. Switch between windows by pressing F6 and CTRL+F6, or by choosing the
open window from the Window menu with the left mouse button.
4. To close the Help window, make it active and then choose Window Close 
(ALT, W, C), or click the close icon in the upper-left corner of the window with the 
left mouse button.

To print a Help topic
1. Display the Help topic you want to print.
2. With the cursor in the Help window, choose File Print (ALT, F, P).
3. Choose OK (ENTER).

To cancel Help in the Help window
KEYBOARD:
* Press ESC.
MOUSE:

 With the left mouse button, click Exit or click the close box in the upper-left 
corner of the window.

To cancel dialog box, message, or definition Help
* Choose OK (ENTER).



Appendix: Changing File Formats

This appendix describes how to use three file-conversion programs supplied with the 
Word package.

In this appendix:
* Converting to and from Document Content Architecture Revisable Format Text 
(referred to in the appendix as “DCA” or “DCA-RFT”)
* Converting to and from RTF (Rich Text Format)
* Converting between Works for the PC and RTF

Converting to and from DCA Format

The WORD_DCA conversion program on the Word Utilities disk 1 converts DCA 
documents to Word format. It also can convert Word documents to the DCA format. The
conversion program works by converting a DCA document into RTF format, and then 
converting it into Word format. The process is reversed to convert from Word to DCA 
format.

The DCA program, WORD_DCA, requires two other programs, each of which has a 
DOS and an OS/2 version. For DOS, the programs are RTF_DOS.EXE and 
DCA_RTF.EXE. For OS/2, they are RTF_OS2.EXE and DCA_RTFP.EXE. The Setup 
program automatically installs these programs, which are located on Word Utilities disk 
1.

As you use the DCA conversion program, you work with an input document (the 
document you want to convert) and an output document (the document in its converted 
form). When specifying either the input or output document, you must type the complete
pathname for the document.

You can start the conversion program from the system prompt or within Word using the 
macros dca_open or dca_save, two of the supplied macros in MACRO.GLY on the 
Word Program disk 3.

A DCA document converted to Word format becomes approximately 25 percent larger; a
Word document converted to DCA format becomes approximately 25 percent smaller. 
These changes are caused by the different document structures on Word and DCA files.
You do not lose or gain any text in the conversion process.

Running the WORD_DCA Conversion Program

There are three ways to start the DCA conversion program:
* You can start the program from within Word using one of the macros that come with 
Word. This is the recommended and simplest method.
* You can start the conversion program directly by typing word_dca at the system 
prompt and following the program instructions.



* You can start the program by typing the command name, input files, output files, 
and type of conversion as one line.

To start the program through supplied macros
1. Choose Macro Edit (ALT, M, E).
2. Choose the Open Glossary button.
3. Open MACRO.GLY from the Word Program disk 3 or your Word directory; 
choose OK (ENTER).
4. Choose Close.
5. Choose Macro Run (ALT, M, R).
6. Run dca_open to convert a DCA file and open it in Word, or run dca_save 
to save a Word file and convert it to DCA format.

To start the WORD_DCA program directly
1. Insert the Word Utilities disk 1 in drive A, or if you have WORD_DCA.EXE 
on your hard disk, change to its directory.
2. At the system prompt, type word_dca and press ENTER to start the 
conversion program. 
3. If the DCA document you want to convert is on a floppy disk, insert the 
disk into your disk drive when you are prompted for the input filename.
4. After you start the WORD_DCA program, follow the instructions and menu
on the screen.

The program prompts you for the type of conversion, the input filename, and the output 
filename. Make sure to type the complete pathname for both the input and the output 
file.

To start the WORD_DCA program by typing input and output filenames as one line
* To convert from DCA to Word, type the following command line:

word -i =input_file1,input_file2,…-c=dca,msw -o=output_file1,output_file2,…

* To convert from Word to DCA, type the following command line:
word_dca -i =input_file1,input_file2,… -c=msw,dca -o=output_file1,output_file2,
…

The variables in the command line are:

-i Indicates your list of input filenames (input_file1, input_file2…)

-c Indicates the type of conversion (DCA to Word or Word to DCA)

-o Indicates the list of output filenames (output_file1, output_file2…) that 
corresponds to your list of input filenames

Spaces are not allowed before or after equal signs or commas, but are required before 
hyphens.



After you convert a Word document to DCA format, you can work on it with any system 
that can read or interpret DCA documents.

Error Messages

Below is a list of error messages you may encounter when using the WORD_DCA 
conversion utility:

Can’t open main document text file.

WORD_DCA cannot find the file you specified as the input file. This message will 
appear if the input file does not exist, the path is incorrect, or the filename is spelled 
incorrectly.

The input file is not a valid DCA/RFT file.

You are attempting to convert from DCA to Word format, but the file you specified as the
input file was not saved in DCA-RFT format.

The input file is not a valid Word file.

You are attempting to convert from Word to DCA format, but the input file is not a Word-
formatted file. To correct the problem, open the file in Word and use the File Save As 
command to save it in Word format.

Cannot write data. Check available disk space.

There is not enough disk space to store the converted document. Before trying again, 
delete unneeded files to make more room, or use a different floppy disk if you have a 
floppy disk system.

Word-to-DCA Conversion Limitations

Character Formats

Conversion from specific Word fonts to DCA fonts can be customized with a DCA font 
mapping file. For more information, see “DCA Font Mapping Files,” later in this 
appendix.
* Text formatted as italic, small caps, or hidden text becomes underlined text in DCA; 
double underline becomes single underline.
* Underline, double underline, and strikethrough formatting becomes normal text in 
5520 DCA.
* All Word font sizes for non-proportional fonts are rounded to the nearest available 
DCA pitch. DCA permits only pitch changes of 5.0, 8.55, 10.0, 12.0, 15.0, 17.1, and 
proportional spacing.



* Font Color is not supported.

Paragraph Formats
* Right-aligned text becomes left-aligned.
* Left and right indents become margin changes.
* Hanging Indents are constructed in DCA. Tabs and Indent Tabs are used to 
maintain the appearance.
* Keep Paragraph Together and Keep Paragraph With Next formats are not 
supported.
* Side-by-Side paragraphs become sequential paragraphs on the same page. The 
original indent settings for each paragraph are preserved.
* Only 0.5, 1, 1.5, 2, 2.5, 3, and 3.5-line spacing convert to DCA.
* Absolutely positioned objects do not translate. They become regular inline text.
* Space before and space after become blank lines with a paragraph mark.

Section Formats
* Page numbering outside of headers is not supported.
* Gutter Margins and Mirror Margins are not supported.
* First-page headers and footers are ignored.

Newspaper-style Columns
* Formatting for Word newspaper-style columns is retained for two or three columns. 
For a document with more than three columns, you have to reformat to a single column 
within Word before converting to DCA.
* Before converting, you must repaginate and enter a hard column break at the end of
each column (CTRL+SHIFT+ENTER). Otherwise, the text translates as one column per 
page.
* The space between columns (in Format Section) must be greater than 0.25 inch.
* Changes to line spacing and font sizes in newspaper-style columns are not 
supported. The first font size and the first line spacing become the font size and line 
spacing for all the columns in the DCA file.

Style Sheets
* When you convert a Word document that has been formatted with a style sheet, 
WORD_DCA converts style sheet formatting to direct formatting.

Merge Information
* Merge instructions and information in a Word document are converted like regular 
text. Merge information includes field names, conditional instructions, and characters 
such as << >>, (comma) =
* The conversion program does not merge information from a data document when 
you convert a main document from Word to DCA format. Information from a data 
document is merged with a main document only when the main document is printed 
through Word.



* The converted file cannot be used as a main document to be merged with a data 
document. The original Word file, however, still can serve as a main document for use 
with Word’s merge features.

Other Features
* Normal and nonbreaking hyphens become required hyphens. Optional hyphens 
become syllable hyphens. All special marks become normal text.
* Glossary text (for example, dateprint, timeprint, or page) does not convert, nor does 
the glossary file attached to the document being converted.
* Leading characters for tab stops do not convert.
* Indexes, tables of contents, and outlining are not supported.
* Graphics do not convert. The tag converts as text.
* Gutter margins do not convert.
* Bookmarks do not convert.
* Autosave files (SVD) do not convert. The file must be a fully saved Word file.

DCA-to-Word Conversion Limitations

For best results, repaginate the DCA document before conversion.

Conversion from specific DCA fonts to Word fonts can be customized with a DCA font 
mapping file. For more information, see “DCA Font Mapping Files,” the next section in 
this appendix.

The following features of Display Write are not supported either by the conversion utility 
or Microsoft Word.
* Document comments are not converted.
* Typestyle is partially supported. It can be customized with the RTF_DCA.DAT and 
DCA_RTF.DAT font mapping files.
* Half justification becomes full justification.
* Page numbering outside of header text is not supported.
* Merge Documents are not supported. All special marks become normal text.
* Symbols that are not resident in the ANSI character set will be translated to _ 
(underscore).
* When converting from 5520 DCA, any bold created with the half up key converts as 
plain text for the original text; the text entered after the half up key code converts as 
superscript.
* Overstrike converts to strikethrough.
* Columns in tables must be separated by at least two spaces to convert correctly.
* Changes in margins are converted to paragraph indents; page size changes are 
ignored.

DCA Font Mapping Files

You can create your own font mapping tables to override some or all of the built-in font 
conversions provided by the conversion utility. All of the mapping tables are ASCII files, 



which you can create in Word. You save the files by choosing File Save As and 
selecting the Text Only format.

The tables are two ASCII files: RTF_DCA.DAT, to map Word fonts to DCA fonts, and 
DCA_RTF.DAT, to map DCA fonts to Word fonts. These files should be in the same 
directory as the document, or in the directory where the conversion program is stored.

Mapping Word Fonts to DCA Fonts

To map Word fonts to DCA fonts, you create the file RTF_DCA.DAT. Each line of the file 
must be in the following format:
WordFontName,WordPointSize[-WordPointSize];GFID[,[Width][,Attribute]]

WordPointSize must be specified in half points. For example, for a 12-point font, 
WordPointSize should be 24.

The following is a sample file:

tmsrmn,0-20;25
tmsrmn,24;26

The first line of the file converts all TmsRmn Word characters between 0 and 10 points 
to GFID character number 25. The second line of the file converts all 12-point TmsRmn 
Word characters to GFID character number 26.

Mapping DCA Fonts to Word Fonts

To map DCA fonts to Word fonts, you create the file DCA_RTF.DAT. Each line of the file 
must be in the following format:
GFID[-GFID];WordFontName,[WordFontFamily],WordPointSize

WordPointSize is in half points.

The following is a sample file:

25;tmsrmn,roman,20
26-30;tmsrmn,,24

The first line of the file converts all GFID character number 25 into 10-point TmsRmn 
Word characters. The second line of the file converts all GFID character numbers 26 
through 30 into 12-point TmsRmn characters.

Using RTF with Word for the Macintosh and Word for Windows

Word for the Macintosh and Word for Windows files saved in RTF include all the style 
information the files have in their original formats. When you convert these files from 



RTF into Word for the PC format, the RTF program gives you the option of either 
attaching an existing style sheet or creating a new one based on the styles in the RTF 
file.

If you choose to create a style sheet, the RTF program maps automatic styles such as 
Normal or Heading 1 to the corresponding automatic styles in Word for the PC. For 
user-defined styles, the RTF program maps style names from Word for the Macintosh or
Word for Windows to style remarks in Word for the PC, and it assigns a style I.D. to 
each style, in ascending order. For example, suppose you have created two paragraph 
styles, List and Note, in a Word for Windows document; saved the document in RTF; 
and then opened it in Word for the PC. The RTF program creates two styles with the 
style I.D.’s, Paragraph 1 and Paragraph 2; it gives Paragraph 1 the style remark “List,” 
and Paragraph 2 the style remark “Note.”

Two-letter style names are mapped to style key codes rather than style remarks. This 
exception is made so that a Word for the PC document moved in RTF to Word for the 
Macintosh or Word for Windows can then be moved back to Word for the PC and 
maintain its style key codes and style I.D. assignments. If you save a Word for the PC 
document in RTF and open it in Word for the Macintosh or Word for Windows, Word for 
the PC style key codes will map to style names. Suppose you have a style named 
Paragraph 1, with the key code PI, in Word for the PC; that style will appear for Word for
the Macintosh and Word for Windows with the style name PI.

If you choose to attach an existing style sheet to the new document being created by 
the RTF program, you have the option of merging styles in the RTF document onto the 
existing style sheet. Style name mapping is the same as when a new style sheet is 
created.

If you choose not to create a style sheet or not to merge styles in the RTF document 
into an existing Word style sheet, the RTF program converts style formatting into direct 
formatting.

RTF Conversion Limitations

Conversion to or from RTF affects the following Word features:

Headers and Footers
* Headers and footers must appear at the beginning of the section in the Word 
document in order to be converted.
* If a header is formatted to appear on odd- or even-numbered pages and the first 
page, the conversion generates two headers with the same text in the RTF file. The first 
header is formatted as an odd or even number, the second as first-page only.
* RTF headers and footers are assumed to run through all sections of the document. 
In Word, they must be reset in every section. This does not affect Word-to-RTF-to-Word 
conversions, but it may affect conversions from Word to RTF, and then on to other 
formats.



Margins
* Top and bottom margins can be set only once in RTF. The first top and bottom 
margin settings in the Word document determine the margins for the entire RTF 
document. Subsequent margin changes in the Word document are ignored.
* Page length and width can be set only once in RTF. The first page length and width 
set for the first section determine the RTF page length and width.

Paragraph Shading and Borders
* Paragraph shading is ignored when converting to RTF.
* Bold Word borders are translated to thick RTF borders.
* Thick RTF borders become bold when converted into Word.

Font Color
* Font color is not translated in the conversion.

Graphics
* Graphics do not convert. The tag converts as text.

RTF Font Mapping Files

You can create your own font mapping tables to override some or all of the built-in font 
conversions provided by the conversion utility. The tables are two ASCII files: 
RTF_PCW.DAT, to map RTF fonts to Word font numbers, and PCW_RTF.DAT, to map 
Word font numbers to RTF fonts. The files must be in the same directory as the 
document or the conversion utility. You can create an ASCII file in Word by choosing File
Save As and selecting the Text Only w/Breaks format.

The entries in the file map Word font numbers to and from RTF fonts. The names of 
fonts are not case-sensitive, unless you are specifying Macintosh fonts. The lines in the 
tables must run in ascending order by the first character of each line (a-z, 0-9). 
Comments may be inserted in the file with a # character, either at the beginning of a line
or after the font mapping entry.

Mapping RTF Fonts to Word Fonts

To map RTF fonts to Word format, you can create the file RTF_PCW.DAT. Each line of 
the file must be in the following format:

FontName;WordFontNumber

The following is a sample file:

courier;8
timesroman;16



The first line in this example changes all RTF characters in Courier to Word characters 
in font 8 (Helvetica). The second line converts all RTF characters in Times Roman to 
Word characters in font 16 (Roman a).

A list of all Word font numbers and what they mean appears in the font table near the 
top of every RTF file. For more information about Word’s font number system, see 
Printer Information for Microsoft Word.

Mapping Word Fonts to RTF Fonts

To map Word font numbers to RTF fonts and font families, you can create the file 
PCW_RTF.DAT. Each line of the file must be in the following format (brackets indicate 
and optional item):

WordFontNumber;FontName[,FontFamily]

The following is a sample file:

8;courier,modern
16;timesroman,roman

The first line in this example changes all Word characters in font 8 (Helvetica) to RTF 
characters in Courier. The second line converts all Word characters in font 16 (Roman 
a) to RTF characters in Times Roman.

Converting Between Works for the PC and RTF

The WORK_RTF.EXE conversion program on the Word Utilities disk 2 converts Works 
for the PC documents to RTF format and vice versa. The Setup program automatically 
installs WORK_RTF.

If you want to use WORK_RTF to do a conversion between Works and Word, you can 
use the macros works_open or works_save, two of the supplied macros in MACRO.GLY
on the Word Program disk 3.

The works_open macro runs the WORK_RTF program to convert a document in Works 
format to RTF format, then converts the RTF formatted document to Word format. The 
works_save macro saves a Word document in RTF format, then runs the WORK_RTF 
program to convert the RTF format document to Works format.

NOTE____________________________________________________________
If your operating system is OS/2, you must run WORK_RTF in DOS compatibility mode.
_________________________________________________________________

Running the WORK_RTF Conversion Program

There are three ways to run the WORK_RTF program:



* You can run the program from within Word using one of the macros that come with 
Word. In addition to starting the WORK_RTF program, these macros also start the 
RTF_DOS program. Using these macros is the simplest (and recommended) way to 
convert documents between Word and Works.
* You can run the conversion program directly by typing work_rtf at the system 
prompt and following the program instructions.
* You can run the program by typing the command name, input files, output files, and 
switch as one line.

To convert documents between Word and Works formats using the supplied macros
1. Choose Macro Edit (ALT, M, R).
2. Choose the Open Glossary button.
3. Open MACRO.GLY from the Word Program disk 3 or your Word directory; 
choose OK (ENTER).
4. Choose OK (ENTER).
5. Choose Macro Run (ALT, M, R).
6. Run works_open to convert a Works file and open it in Word, or run 
works_save to save a Word file and convert it to Works format.

To start the WORK_RTF program directly
1. Insert the Word Utilities disk 2 in drive A, or if you have WORK_RTF.EXE 
on your hard disk, change to its directory.
2. At the system prompt, type work_rtf and press ENTER to start the 
conversion program.
3. If the Works document you want to convert is on a floppy disk, insert the 
disk into your disk drive when you are prompted for the input filename.
4. After you start the WORK_RTF program, follow the instructions and menu 
on the screen.

The program prompts you for the type of conversion, the input filename, and the output 
filename. Make sure to type the complete pathname for both the input and output files.

To start the WORK_RTF program by typing input and output filenames as one line
* To convert from Works format to RTF format or RTF format to Works format, type 
the following command line:

work_rtf[inputfile [outputfile]][ /o]

All variables and switches are optional. They are described in the following list:

inputfile The filename of the Works or RTF file you want to convert. If 
inputfile is in Works format, ouputfile will be in RTF format, and vice versa. If the 
file is not in the current directory, inputfile should include the file’s pathname.

outputfile The filename of the converted file. Outputfile can include a 
pathname.



/o Allows the file being created in the conversion (outputfile) to overwrite the 
existing file (inputfile).

The WORK_RTF program automatically detects the format of inputfile and performs the 
appropriate conversion—Works to RTF, or RTF to Works.

As an example, if you type work_rtf test.wps test.rtf, the WORK_RTF program 
converts the document to TEST.WPS from the Works format and creates an RTF 
document, TEST.RTF.

Unless otherwise specified, the filename extensions will be .WPS for Works documents 
and .RTF for RTF documents.

You can also use wildcards when specifying filenames—for example, *.RTF or *.WPS.

Word-to-Works Conversion Limitations

Since RTF is used as an intermediate format between Word and Works formats, the 
same limitations that apply to RTF conversion also apply to conversions between Word 
and Works. For more information, see “RTF Conversion Limitations,” earlier in this 
appendix. In addition, other limitations specific to Word and Works apply. These 
limitations are the following:

Headers and Footers
* Headers and footers must appear at the beginning of the section in a Word 
document in order to be converted. Likewise, they must appear at the beginning of a 
Works document.
* Only the last header or footer defined in the Word document is preserved in the 
converted Works document.
* If a simple Works header or footer has more than one alignment, each separately 
aligned part is converted as a separate paragraph in Word.

Other Features
* Word style formatting converts to direct formatting in Works.
* Word side-by-side paragraphs convert to ordinary paragraphs in Works.
* Word absolute position formatting does not convert to Works.
* Word table of contents and index entries do not convert to Works format; indexes 
and tables of contents are preserved, however.
* Word glossary and outlining do not convert to Works.
* Word annotations convert to Works footnotes.
* Only the first character of user-defined footnote reference markers converts from 
Word to Works.
* Works tab leaders for default tab stops do not convert to Word.
* The &f special character in Works does not convert to Word.



WORK_RTF Font Mapping Files

Works and Word use the same set of printer drivers, so font mapping between a Works 
document and a Word document should not present any problems, provided the same 
printer driver is used with both programs.

However, you can create RTF font mapping tables to override some or all of the built-in 
font conversions provided by the WORK_RTF program. These font mapping tables are 
described earlier in the section “RTF Font Mapping Tables.” The only difference is that, 
instead of using the filenames RTF_PCW.DAT and PCW_RTF.DAT, the WORK_RTF 
program requires filenames RTF_WWP.DAT and WWP_RTF.DAT. The filename 
WWP_RTF.DAT is the filename of the table for mapping Works fonts to RTF; the 
filename RTF_WWP.DAT is the filename of the table for mapping RTF fonts to Works.
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